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1 Introduction 
This manual is written to assist users to configure and use iCar. The descriptions aims to control 
digital modelcars. 
The first part will describe the general way of working and the most important parameters of the 
program. Then the definition and control of the cars is described. Finally the switchboard and 
according elements wil be declared. 
For driving trains in combination with cars we have to refer in addition to the iTrain manual. 
 
When you start working with iTrain for the first time you will need to know some basic concepts of 
the program. 

1.1 The main window 
An ordinary screen in iTrain may look like the following : 

 
In this screen we can identify three main areas: 

1. The overviews in the upper left corner give an overview of the status of every car and give 
immediate control over their main functions; 

2. The control or throttle in the lower left corner gives more control over all the settings of a car 
and is meant to control it in detail; 

3. The switchboard on the right side is a simplified drawing of your layout, in which you see 
where your cars are and what the state of all turnouts, signals and other objects is. You also 
can change the state of all objects. 

1.2 Main objects 
In iTrain we distinguish several types of objects for cars: 

• Interface - refers to the connection with a command station or other device to control the 
layout; 

• Feedback - refers to sensors in the lane that detect if part of a lane is occupied or not; 

• Accessory - switchable objects; 
o Turnout - is the switch to either join multiple tracks in one or split one track into 

multiple tracks; 
o Signal/Trafficlight - may either refer to actual traffic lights on the layout or only to 

virtual traffic lights on the switchboard to indicate if a car should stop or is allowed 
to drive; 

o Crossing - is a crossing between the road and the railroad; 
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• Car - refers to a specific car; 

• Car type - refers to a category of cars with similar behaviour; 

• Lane - is a part of a track (not including turnouts) where more cars can drive at the same 
time; 

• Intersection - is a gathering of lanes most of the time including traffic lights; 

• Switchboard - is the presentation of the layout in which most of the objects can be switched 
or viewed. 

1.3 Naming 
In iTrain, all cars, turnouts, traffic lights and all other objects have a name that is unique per object 
type. You do not have to remember all the addresses, because you can give every object a useful 
name. It is recommended keeping the names short and using a naming convention that you 
understand. Every object can also have a description to give a more descriptive name to your own 
wishes, but the description may be left empty as well. 
For example, for the name of a car you can use the company name like DHL or GLS 
followed by a number of the car, for example DHL01.  
For the names of lanes and accessories you can use logical numbers prefixed by an identification of 
the position on the layout.  
 
Note: It is recommended naming your objects independently of the actual address of the object and 
choosing a more logical name based on the location in the layout. The address will be displayed 
between parentheses behind the name. In many cases you may need it (such as with selection boxes). 
 

1.4 File handling 
After you have started iTrain for the first time, no file has been associated with your project so you 
have to save your project with a specific name. It is recommended using the extension .tcdz for iTrain 
files (tcdz =Train Control Data Zip), for example layout.tcdz, and saving them in the folder 
iTrain/layouts in your home directory and not in the folder Applications (or Program Files for 
Windows). On Mac OS X this folder will not be created by the installer so you have to create it 
manually once. 
 
Note: On OS X the .tcdz files will get a special icon to indicate that it is an iTrain file and you can 
double-click it to open the file. 
 
The next time you start the program, it will automatically try to load the same project. The project 
name will be shown in the title bar of the main window together with the full path to the file and the 
iTrain version in which it was created. 
When closing the program the project will be saved automatically, unless you have chosen to do that 
manually. This will not only save the definitions of all objects, but also the current state of the layout 
(where are the trains and what was the last state of all accessories). 
 
Backup 
Before saving a file, the previous file (with the same name) will be moved to a backup subdirectory 
and the date and time will be added to the file name. This way you always have a backup of the 
previous states of your layout in case something goes wrong. The name of the backup files have the 
following format that includes the original name followed by the word backup, the date and time of 
creation of the backup and the version of iTrain with which it has been saved. 
  layout_backup-20191209-190742_v5.0.0.tcdz 
To restore a backup, just open the file from the backup subdirectory in iTrain and the original file 
name and path will be restored. So it is not necessary to copy and rename files from the backup 
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directory. The backup directory may fill up fast with every save, but the files are generally small 
compared to the available disk space. You could clean them up if you want, but in general it is not 
necessary. 
 
Recent files 
The menu item ‘Open recent files’ shows a list of up to 10 files that have been opened recently. You 
can go back to an earlier opened file quickly by selecting it from the list, but do save the current file 
first if you have made modifications that you want to store. 
 
Import 
The import allows you to open a file as well. But it will import only the cars. The import will add this 
part to your already loaded file. The import dialog contains a tab, showing all cars which can be 
imported. You can now select the cars you want to import and also indicate whether they should be 
imported actively or inactively. Possible conflicts with existing cars are displayed in the last 2 columns 
“Duplicate” and “Addresses in use with”. 
 
Export 
The export allows you to export the most important objects (cars, accessories, feedbacks and lanes) 
as different .csv files (tab separated, encoding UTF-8) that can be read immediately by a spreadsheet 
program. In the export these .csv files will be bundled as a zip-file. Because every object can have 
only one line with columns for their properties, only the single value properties of an object will be 
exported and not the complex properties that are lists or tables in themselves. 
A more detailed description can be found in the iTrain5 manual. 
Note: The exported files are only for analysis or bookkeeping and cannot be imported by 
iTrain. 
 

1.5 Online 
When you are working with the program sometimes you only want to change your configuration 
where at other moments you are really controlling the cars on your layout. In the second case you 
will need a connection to the control device and when this is done the program is ‘online’. 
In the right lower corner of the screen you can see whether you are ‘Online’ or ‘Offline’. 
This is the current status. With the button on the toolbar you can change the status to ‘Online’ (text 
below button is ‘Connect’) or ‘Offline’ (text below button is ‘Disconnect’). 
Note: It is always recommended selecting ‘Disconnect’ or exit iTrain before turning off your control 
device so that it can disconnect correctly. If you accidentally turn it off before going offline then check 
if the program did detect it or else do it manually instead. 
 

1.6 License 
iTrain is a commercial product and runs by default in demo mode. You are limited to 3 cars and 32 
accessories and 32 feedbacks. This allows you to test iTrain on a small demo layout. 
To make use of all features available in iTrain you have to register and you will get a license that is 
coupled with your e-mail address. To enter your license number go to main menu "Options => Enter 
license key". 

 
Type or copy your e-mail address that you used to get a license and 
paste your license key into the ‘License Key’ box by using <Ctrl> or 
<Command> + <V> key or the popup menu. It is not recommended 
typing it manually. 
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If your registration succeeded you will see the about box with your license type, name, contact 
information, e-mail and optionally the end date of the license. 

 
 

1.7 Project 
Now you are ready to enter your model road into iTrain. We call this the project. All the project data 
can be entered via the different items in the ‘Edit’ menu and will be saved in the project file except 
for the preferences that will be stored somewhere on your computer and will remain the same even 
if you change the project. 
First check the preferences and the settings and choose the interface before you continue with 
entering your layout. The next step could be entering cars to test your connection, but this can be 
deferred to a later stage as well. A good strategy is to first draw the whole layout, then assign all the 
turnouts, traffic lights, feedback and lanes to the drawing and finish with the cars. 
 

  

Name, address and 

contact user 
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2 Preferences 
The preferences are settings that apply to all projects and are saved on the computer itself in an 
application specific location. You can find them in the iTrain menu on Mac OS X or at the bottom of 
the ‘Edit’ menu on other operating systems. 
 

2.1 General 
In the ‘General’ tab you can change some specific settings of 
the behaviour of iTrain. It is possible to save the project when 
closing iTrain without asking for confirmation. By default a 
check is done if a newer version of iTrain is available at startup. 
If your computer is never connected to a network you can turn 
this off. 
 
 

 
 
Look & Feel 
Every operating system has its own look & feel and sometimes you can even choose themes. iTrain 
by default follows the look & feel of the operating system, but it is possible to choose another one 
for consistency among computers. The recommended cross platform look & feel is ‘Nimbus’ that is 
now used by default on Linux. Changes to the look & feel will not be active immediately, but only 
after a restart of iTrain. 
 
Language 
The iTrain user interface is available in multiple languages. By default it will choose the same 
language as the operating system and this is called ‘System Default’, but you can change it to a 
language you prefer. The changes will not be active directly, but only after restarting iTrain, because 
the user interface has to be reloaded. 
 
Length unit 
The length unit specifies what kind of measure is used throughout iTrain for displaying length. It is 
recommended to use centimeters, because that will fit naturally with the scale of most models and is 
also used internally. Millimeters, meters, inches and feet are also selectable options. Length values 
are floating point values so you can have 51.5cm or 0.515m. In every length input box in the program 
you can always enter a value in another unit by adding the unit to the value. It is automatically 
converted to the unit specified in this preference after hitting the <ENTER> key. The possible suffixes 
for length units are ‘mm’, ‘cm’, ‘dm’, ‘m’, ‘in’ and ‘ft’. When you do not specify a unit in a length input 
box, the default specified in the preferences is assumed. 
 
Speed unit 
The speed unit specifies what kind of measure is used for displaying speed corrected for scale 
throughout the application. The natural unit would be km/h or mph, but also m/s is possible. Speed 
unit values are also floating point values. In every speed input box in the program you can always 
enter a value in another unit by adding the unit to the value. It is automatically converted to the unit 
specified in this preference after hitting the <ENTER> key. The possible suffixes for speed units are 
‘cm/s’, ‘m/s’, ‘km/h’ and ‘mph’. 
 
Base path 
This is the path where the iTrain data is stored. The path refers to the location where iTrain is located 
containing the images, layouts and sounds folders. 
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2.2 Switchboard 
The ‘Switchboard’ tab has some generic settings for the 
switchboard that apply to all projects. The option ‘Default grid’ 
decides if a new switchboard or the switchboards in a newly 
opened project will be shown with a grid. It will not affect current 
switchboards, because you configure it for the existing switchboard 
via the popup menu. To automatically use the maximum allowed 
zoom that does not need scrolling for newly opened projects, select 
‘Default fit’. 

 
The look or appearance is a set of colours, line widths and text size used to draw the layout. 
There are three looks available: 

• Classic - a white background and drawn as in all previous versions; 

• Contrast - with a light gray background that is easier for the eyes and makes the colours 
better identifiable, somewhat bigger font for better readability; 

• Dark - using a dark background and lighter track lines so colours of feedbacks and signals 
have better contrast. 

2.3 Interface 
 
Grouping 
Grouping is another way of displaying the address of an 
accessory or feedback with two numbers and a dot in the middle 
(<module>.<output> format). In iTrain every object has its own 
absolute number, but in many command systems addresses are 
written with group or module numbers and sub numbers. 
A few examples: 
• the address 1 is written as 1.1 when used with grouping. 
• the address 33 is written as 2.1 when used with grouping or 
module size 32. 
The general formula is: address = (module number - 1) * group size + output number 
A grouping of 32 e.g. is used for OM32 and OC32. 
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3 Settings 
The project specific settings are saved in the configuration file and will be the same on every 
computer using this project. You can configure the settings via menu “Edit => Settings”. 
 

3.1 General  
 

Scale 
The most important setting is the track scale that is used for the speed 
and distance calculations. For modelcars this will normally be H0 (1:87) 
or N (1:160). 
 
Time 
Factor is used to indicate how fast the time on the layout should go. A 
value> 1 will move time faster. "Start" and "End" indicates which parts of 
a day will be used. 

 
 
 

3.2 Options 
'Always set accessory' will switch all the assecorries when starting 
iCar. This will avoid assecorries to be in a different state then iCar 
expects.  
The option 'Reset turnouts after release' will setback turnouts 
always in the startposition. This can also be defined for each 
individual turnout.  
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4 Interface 
The program communicates via USB with the device for modelcars. Selecting the right interface will 
give the possibilities for controlling modelcars. 
 

 
 
Via the menu “Edit => Interface” you can select the ‘Interface’ that is connected to your computer. In 
case of controlling cars this should be MCC (UCCI), Dinamo (RMU) or BiDirectional Bus (BiDiB).  
The ‘Description’ field allows you to change the description of the interface in the application. On the 
tab at the bottom you can see how the interface will be displayed including the number in front of it. 
 
For use of multiple interfaces, please consult the iTrain 5.0 manual. 
 
By default an interface for modelcars will control the vehicles and accessories, and read the 
feedbacks in iTrain. Although it is possible to restrict the ‘Control types’, we recommend to use them 
all for controlling cars. 
More specific interface settings have been divided over multiple tabs in top called ‘General’, 
‘Connection’, ‘Specific’ and ‘Image’. 
 

4.1 General 
The option "Send stop at disconnect" will send a stop signal to the central station when the program 
stops so that cars do not continue to drive uncontrolled. 
 
The ‘Activation time’ is the default time between the activation of an accessory and its release. This 
can be overridden per accessory.  
By default all accessories are activated when going Online so the state on your layout and in iTrain 
will be identical.  Switching this off can cause collisions of cars while switches might not be at the 
state  iTrain is expecting. 
Feedbacks are the eyes of the program and it is important they deliver good results. In some cases it 
is necessary to filter the raw input to remove short spikes because of bad contacts. 
The ‘Switch on delay’ is the time a feedback needs to be on before the feedback sees it as on.  The 
same holds for ‘Switch off delay’, so an off is only seen after some time without an on. In general it is 
important to keep the ‘Switch on delay’ short, because most actions are based on a feedback going 
on and it might delay the action. In most cases you can leave it to zero, but if you use it then take a 
small value (<50ms). 
The ‘Switch off delay’ for cars is also critical, then this indicates the next car can pass. While cars can 
drive very close to each other, short contact loss might cause a collision. Therefore a short delay is 
preferred to unwanted release. Common values for ‘Switch off delay’ are in the range 100-500ms. 
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This feedback filtering is the default setting for all feedbacks attached to this interface. It can be 
overridden for any individual feedback. This is useful if you combine feedback modules with different 
characteristics. 
 
Note: Filtering the feedback output also results in fewer transitions from on to off and back again and 
will improve the overall performance of the application, because actions and checks will not be 
executed unnecessarily. 
 

4.2 Connection 
The carsystem has a serial interface by means of a USB 
connector. Using the USB connector you have to install a 
Virtual Serial Port (VCP) driver: 
https://www.ftdichip.com/Drivers/VCP.htm. 
On the ‘Connection’ tab you always have to select a port. 
Using the ‘Refresh’ button will give a recent list of choices for 
ports. All other settings have a default value for this interface. 
 
 
 

4.3 Specific 
The tab called ‘Specific’ contains in case of the MCC (UCCI) interface only the ’Transmission interval’. 
This is configurable, but in general keep it on the default value of 5ms. 
For the Dinamo (RMU) interface and BiDiB there are some more variables besides the ‘Transmission 
interval’. For cars normally the standard values will be used.  
 

4.4 Status 
The status of all interfaces is shown on the right side of the status bar. It shows the name or 
description of the interface including the indication  (Online) or  (Offline). 
By hovering over the name of the interface it will show between bracket the letters VAF or a subset 
indicating the interface has been configured to control (V = Vehicles;  A = Accessories; F = Feedbacks). 
  

https://www.ftdichip.com/Drivers/VCP.htm
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5 Cars 

5.1 Create or edit a car 
To get into the ‘Car editor’ you go to the menu “Edit => cars” or press <Ctrl> + <F10>. 

 
At the left side is the list of cars known by iTrain. This is typically your whole collection. In the 
‘Active’column you can indicate which cars are currently available on the layout, so that elsewhere in 
the program where you have to select a car only the active cars are shown.  
To manage the list of cars you use the buttons below the list. You can add a new car by using the 
‘New’ or ‘Copy’ button. In case of ‘Copy’ the currently selected car is used as a template and its 
definitions are copied to the new car. Only the name is adapted to create a unique name. The 
‘Delete’ button removes the currently selected car from the list. 
 
On the right side you find the car editor to change all car definitions. You have to fill in at least a 
name, decoder type, interface, address and speed to be able to drive the car. 
The buttons below the editor give some extra control over the editor: 

• The ‘Apply’ button applies changes you made in the input fields. This will immediately be 
reflected in all windows. If you select another car the previous selected car will automatically 
be applied; 

• The ‘Reset’ button discards the changes you made in the editor and reloads the fields with 
the current value. After an ‘Apply’ a reset will only discard changes made after the ‘Apply’; 

• The ‘Clear’ button clears all the fields. 

5.2 Car definition 
Give the car a unique ‘Name’ and a corresponding ‘Description’. Keep the ‘Name’ as short as possible 
because it keeps the presentation in the switchboard clear. 
It is important to specify the ‘Car type’ correctly when driving automatically, because the type will 
determine the behaviour and routes of the car. 
The following ‘Car types’ have been defined: 

• Default  (no specific type car) 

• Truck   

• Bus 

• Garbage 

• Ambulance 

• Police 

• Fire 
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Specifying the ‘Length’ of the car is necessary in order to calculate the space needed in a lane and 
also the stopposition of the next car. 
In the ‘Decoder’ section you can specify the decoder ‘Type’ (MCC or DCC), the ‘Interface’ (the 
carsystem) and the ‘Address’. The field ‘Node’ at the BiDiB interface is preferably left blank for 
optimum operation. 
  
Image 

 
The first tab ‘Image’ allows you to add an image to your car. 
An image has a preferred size of 360x160 pixels that is 
prepared for high-resolution displays, but images of 180x80 
pixels are still allowed.  
 

Use the ‘Find’ button to add an images. Standard is the search at the installed ‘Base path’. It is 
recommended to save all images on this place. 
Large images are always downscaled to fit in 360x160 pixels before they are used in iTrain. If your 
image is much larger, you can first scale it down in another program, but you can also let iTrain do it.  
 
Speed 
The second tab ‘Speed’ shows the speed related properties. The 
upper part shows the real speed characteristics in km/h of the 
car against the decoder steps. You can use the speed 
measurement via menu “View => Speed Measurements=> Cars” 
(described later) to do the actual speed measurements in iTrain 
or manually enter the values if you calibrate outside of the 
program. 
At the bottom, the maximum speeds when driving automatically 
can be specified. Uncheck the box ‘Maximum’ if there is no 
maximum speed for the car. 
 
Functions 

On the third tab ‘Functions’ you can assign the car functions to 
the correct f-keys. MCC decoders always have four basic functions 
(light, brakes, indicator left and indicator right). OpenCar 
decoders control the brakelights by themselves. Therefor only 3 
basic functions (lights and indicators) will be used. Depending on 
the decoder additional free functions can be defined. 

A function can be assigned to an f-key by checking the first column ‘Use’ and selecting a type from 
the ‘Type’ column. Automatically, a default description will appear that you can edit to describe the 
function in more detail. The ‘Momentary’ box checked means that the function will only be activated 
as long as the corresponding button or key is pressed, for example for bright light. 
 
Configuration 

The fourth tab ‘Configuration’ is used to define which CV 
values of a car can be read and written. This option is only 
used for DCC decoders. With ‘Used’ you can indicate which 
CVs can be accessed with the decoder programming. ‘Value’ 
is the last known setting of the CV as stored in iTrain. Under 
‘Description’ it can be indicated in iTrain what the CV entails. 
It is only a description that is used in iTrain. 
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Options 
The fifth tab ‘Options’ shows some extra options for cars.  
The option ‘Auto light on/off’ gives the possibility to switch on the lights of a car when driving 
automatically. If this option is not checked, the light of a car must always be switched manually or via 
a defined action. 

 
Inertia simulation 
The inertia simulation works by delaying the speed steps 
sent to the decoder. Single steps are executed almost 
immediately, but when a speed change requires multiple 
decoder step changes, the intermediate steps are sent with a 
delay between the step change as specified.  
You can set the inertia simulation separately for the 
acceleration and braking. The first value is the step delay and 
the second value the step size. To disable iTrain inertia 
simulation, uncheck the boxes. When activating a car 
function called ‘Direct Control’, the iTrain inertia simulation 
is also disabled for that car. 
 
Note: Good values for the inertia simulation are typically between 100ms and 500ms. Do not use 
lower values than 100ms, because that does not allow a speed command to be sent by the ‘Interface’ 
and processed by the car before another speed command will be sent. 
 
Feedback Offset 
When using occupancy feedbacks these are normally triggered by the magnet of the car. In some 
cars this magnet is not at the frontline of the car (e.g. by busses). So when the feedback is triggered 
the car might already somewhat further than expected. To correct this error, you can specify the 
offset from the front of the car. 
 
Reaction Delay 
The reaction delay is only used when using ‘Positions’ (described later). With ‘Positions’ you can use 
exact positions (for example in cm) in the lane to stop a car based on time/distance calculations. 
Normally there will be an offset error at the entry of a lane, because calculations are relative and not 
absolute. By experimenting with the reaction delay you can correct this offset for multiple lanes.  
 
Period 
Here you can specify after how many hours a car needs maintenance and how long a car can run with 
a full battery. The times are measured or calculated based on the driving time of a car. The battery 
symbol can be shown in the car overview and thus indicating that a car must drive to a charging 
point. In addition to showing, the signal can also be used as a condition to start an action. The 
maintenance time is for information only and is not yet being used. 
 
Routes 

Here a selection of active routes can be made that may apply to 
this car. The routes are defined elsewhere (see 6.10) and 
possibly made active. 
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Permissions 

The tab ‘Permissions’ is to exclude access (‘No access to’) or only 
allow access to (‘Only access to’) specific lanes for this car. Use 
the buttons on the right to add rows and use the lane input box at 
the bottom the change the lane of the selected row. In some 
cases the lane should/should not be accessible in a specific 
direction. For those cases change the ‘Direction’ column as 
required. 
 
 
 
 

 
The last tab ‘Comment’ allows you to add comments about the car. You can use it to write 
maintenance remarks, info about the car in real life or anything else you find useful. 
 

5.3 Car control 
To control one or more cars, you can use the overview, ‘Car control’ or grid. 
 
Overview 

The car overview in the upper left corner shows all active 
cars with some of the important settings. By default a small 
image of the car, the name, the actual speed, the signal 
facing the car and the current lane are shown. It is easy to 
add more information in this verview. In the example 
besides also the decodernumber, status of battery, position 
in the lane and activated route is presented. 
The  button will start automatic driving for a car and the 

 button will stop automatic driving.  
 

 
 
Which property is shown in the columns of the overview can be changed by right click on table 
heading and selecting ‘View Columns’. It is also possible to automatically sort the cars on some of its 
more static properties (Address, Name, Description, Type, Route, Decoder and Interface). 
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Control 
The ‘Car control’ is used to have full control over the car while at the same time having all the 
information available in a nice way. It consists of three tabs. 
 

 The first tab ‘Control’ is the main tab for directly controlling 
the car. To select a car in the ‘Car control’, you can use the 
drop-down box (only the active cars are shown) in the left 
upper corner or you can select via the ‘Car overview’  by 
double click on the car, drag (from overview) and drop (at 
‘Car control’) or select a row with a car in the overview and 
press <ENTER>. You will get a picture of the car, the current 

signal state the car is facing a trafficlight in the lane, a speed control, the current lane, info, the 
decoder step and all the car function states. 
 
To modify the speed there are several options: 

• Move the slider that represents the decoder steps. Double click will stop the car; 

• Use the scroll-wheel of the mouse while the mouse is positioned in the ‘Car control’ to 
change the speed in decoder steps; 

• Use the ‘+’key to increase the speed and the ‘-‘key to decrease the speed. The speed will be 
changed to the previous or next speed that can be divided by 5; 

• Use the number (0-9)keys on the keyboard to set the speed from 0 to 90km/h in steps of 
10km/h, and use the Shift key in combination with these keys to set the speed from 100 to 
120km/h. 

 
The speedometer shows the real speed in km/h according to the speed measurements. In case of no 
speed measurements the maximum decoder speed is considered to be 120km/h.  
In the gray rectangle of the speedometer you see two speeds: the desired speed at the top and the 
real speed that the car is driving below. These two speeds might be different if the desired speed 
cannot be matched exactly with a decoder step. In that case the decoder step is chosen whose real 

speed closely matches the desired speed while at the same time not topping it by 
more than 5km/h to prevent it from going much faster than desired. 
 
Functions can be changed by pressing the button with the function icon. For many 
function types a special key is reserved, as can be seen in the popup menu 
attached to the ‘Car control’ or ‘Overview’ (both right mouse click). 
Momentary functions will only be activated as long as the button or key is down. 
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All other functions will change their state when pressing the button or key.  
 
The drop-down box at the right upper corner is for setting the control type of the car. There are 
three options: 

• Manual control: the program will not influence the car in anyway, but it still tries to follow 
where the car is on the layout; 

• Semi-automatic control: the program will only reduce the speed of a car whe the car needs 
to stop; 

• Automatic control: the program automatically sets the speed to the maximum allowed by 
the car in combination with the lane, and stops the car if necessary. The  button will start 
automatic driving for a car and the  button will stop automatic driving.  

 
As extra information the facing trafficlight for the driver is shown by a symbol between the car image 
and the speedometer. If no signal has been defined on the layout on that position, ‘Sight*’ will be 
shown. 
Below the car image, the current lane and info is displayed. The latter, among other things, displays 
reports about incorrect driving of cars. 
 
Options 

 
The second tab ‘Options’ shows properties that less frequently changes. The first input is to select 
the car in control, just as on the first tab. The second field 'Route' can be used to select an available 
route for this type of car. 
You can select one of the 8 profiles (0-7) from the MCC decoder driving a car. Standard is profile 1. 
For Opencar decoders the profile is not used. 
The button ‘Reset totals’ is to reset the total time and distance travelled by a car to zero. 
 
The third tab contains the comments for a car. This is the same content then the ‘Car editor’. 
 

5.4 Car Grid 
In stead of having one ‘Car control’ it is possible to have multiple ones. They will be shown in a grid, 
so next to each other and/or above each other (no feature at standard version). 
 

 
To add or remove extra car controls , one car control needs to have focus (press F3) and you can use 
the <Alt> + <cursor> keys to size the grid. 
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<Alt> + <cursor right> will add controls to the right (columns) and <Alt> + <cursor down> will add to 
the bottom (rows). To remove car controls use <Alt>+<cursor left> for a column and <Alt>+<cursor 
up> for a row. 
The focussed car control has a border drawn around the car image. To navigate between the car 
controls use <Shift >+ <cursor> keys. To change the selected car within a car control you can use the 
<ENTER> key to popup the list with cars and select one with the cursor keys followed by pressing 
<ENTER>. 
 

5.5 Programming decoders 
Each decoder has a list of configuration variables that determine the behavior. A simple example is 
the address of the decoder, but there are also complicated settings. There are many tools available 
to configure the decoder the way you want. Programming decoders in iTrain is not included to 
replace all these tools. It is intended as a basic programming tool to make the most common settings 
without closing the interface in iTrain. 
 
Configuration 
The first step in programming a decoder is to specify the configuration. 
 

The properties of a car have a ‘Configuration’ tab with a table. All CV 
numbers are present in this table. You first have to indicate for which 
numbers values are present (by checking them) and what the type of 
the value is (by double-clicking and selecting from a list). You can also 
enter your own description in the last column. It is not immediately 
necessary to enter a value, but if you already know the value, it is 
recommended to do this immediately, so your complete administration 
is at one place. 
 

Values are always stored internally as decimal values, but depending on the type, the values will be 
displayed in a different format if that makes interpretation easier (eg a supplier is translated into a 
name). There is always the possibility to view the value in decimal, binary, hexadecimal or ascii 
format via the tooltip. When entering a value, a decimal value is expected by default, unless you put 
a prefix before it. The prefix "b" means that a binary value follows, "h", "x", "#" or "$" means a 
hexadecimal value and a quotation mark means a letter (so "A" is the same as 65). 
 
It is a lot of work to enter the configuration for each car. By using the popup menu of 
the table you can do it a bit faster by copying the definitions from other cars. Select 
the rows that you want to copy and paste them into another configuration that uses 
the same numbers. There are also a few standard templates for the most common 
variables / parameters for DCC. 
 
Programmingtool 

If you have made a configuration for a car and iTrain supports 
programming with your interface (central or programming train), 
you can read and/or write values with the programming help in 
iTrain. You can find this programming help in the menu "Show" -> 
"Decoder programming". You must then use the submenu to 
choose which type of object you want to program. 
 
First you have to select the car. Then the table with the 
configuration will appear, but only with the relevant numbers. 
Then select the interface with which you want to program from a 
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list of usable interfaces. The ‘Program Track’ or ‘Main Track’ (= PoM) options do not apply to cars. 
 
Now you can start exchanging data between iTrain and the decoder by choosing the rows and then 
pressing ‘Read’ or ‘Write’. 
 
Note: It is necessary to first create the configuration of the car, as described in the previous section, 
before you can read or write anything. This way you know what you read or write. 
 
While reading or writing the values, a green arrow 
will appear in the ‘Value’ column, which means that 
the process is working on this line. If the action is 
unsuccessful (for example because there is no 
response within a certain time), a red icon will 
appear to indicate that the value is probably not written or read. 
 
It is possible to adjust the values in the table before you write a value or start reading from the 
decoder, but the values are only stored with the car after the ‘Apply’ button has been pressed. In 
case you accidentally read the values of another decoder, you can therefore restore the original 
values in the table by pressing the ‘Reset’ button. If you want to clear all values before you read, 
press the ‘Empty’ button. 
 
Special values 
The configuration of some DCC variables requires some extra attention, as they are often used and 
available on almost any decoder. 
 
Long address 
In the past, most decoders only had a short address (7-bit) with values from 1-127 (sometimes even 
limited to 2 digits, therefore 1-99). Later the option came to use a long 4-digit address. To specify 
such a long address, 2 variables are needed. For DCC these are CV17 and CV18 and these must have 
the types ‘Long address high’ and ‘Long address low’. To enter the address you must make a division 
with remainder to split the address into a quotient and a residual value: 
CV17 = (address divided by 256) + 192 
CV18 = (address modulo 256) 
 
For example, at address 360 you must use the following: 
CV17 = 1 + 192 = 193, CV18 = 104, (L = 1 * 256 + 104 = 360). 
 
In the table, CV17 will now be shown as L256 + and CV18 as 104. The L means that you have correctly 
added the value 192, which means Lang address. The + at the end indicates that the following value 
(CV18) must be added to get the full address. 
To actually use this long address, the correct bit in CV29 must be set to 1. Sometimes this happens 
automatically, so to be sure, read CV29 just after writing CV17 and CV18. 

5.6 Speed measurements 
In all the settings of speed a normalized speed in km/h is used. This makes it easier to compare 
speeds of different cars. By default the program does not know which decoder speed step belongs to 
which real speed and it assumes that the maximum decoder step is 120km/h. All steps in between 
are linearly interpolated. Of course this is rarely the case and you have to measure the speeds of 
your cars for correct behaviour when driving automatically. 
 
To calibrate the speed of your car, you can use the special calibration tool by going to menu ‘View => 
Speed measurements => Cars’.  The car in the main car control will be selected already. 
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Type 
Speed measurements are all based on a car driving 
with a fixed speed between two positions and 
dividing the distance by the time it takes to drive 
this distance. The value is then corrected with the 
model scale. 
For cars we use most of the time the method of two 
feedbacks with some distance in between. One 
measurement starts when feedback 1 is activated 
and is ready when feedback 2 is activated. It is also 
possible to advance measurements with a 
speedometer. This must then be defined with type 
‘Device’. 
 
Measuring 
To do the actual speed measurements, select one or 
more rows with speed steps in the measurements 
table (left side) and press ‘Start’. All buttons will be 
disabled except for the ‘Stop’ button until all 

selected steps have been measured. A clock icon will appear in front of the value that will be 
measured. When the first feedback is activated the icon will change into a green arrow to indicate 
that measurement of this value has actually started. When the second feedback is activated the 
individual step measurement has been done and the icon will change into a ‘checked’ icon. When 
multiple rows have been selected the next value will be measured until all values have been 
measured. 
 
Note: cars should be able to drive in a circle so measurement of different steps can be done 
automatically. 
Note: The order of selection is important when selecting multiple rows and determines if the steps are 
measured from low to high or high to low. It is preferable to measure from high to low speeds. 
 
At any time during the measurements you can press ‘Stop’ to abort. When doing the speed 
measurements one at a time, you can use the ‘Next’ or ‘Previous’ button to measure the speed for 
the next or previous decoder step. 
Note: Values can also be edited manually. To clean a value, you have to select a row and press 
<DELETE>. 
 
It is not always necessary to measure all steps, and values can be left empty or zero. Always measure 
the first step for which the car starts to move. This is the minimum step. All decoder steps before the 
minimum will not be used by automatic control and are considered idle steps. The last step with a 
value greater than zero is considered to be the maximum step. All steps that are left empty or zero 
between the minimum and maximum speed will be interpolated as soon as the ‘Apply’ button is 
pressed. 
Note: All speed measurements should increase with every step to make them useful in controlling the 
car. You can check this easily in the graph. If values are not increasing, they will be sorted after 
pressing ‘Apply’ and after the optional interpolations. 
Note: The car function ‘Direct control’ will be activated when doing speed measurements to disable 
the inertia simulation in the decoder. The car will get to the measured speed faster and it will brake 
faster giving a more precise measurement and taking up less track space for high speed 
measurements. Take care that the ‘Direct control’ function does not reduce the speed. In that case 
change the type of the function to ‘Slow’. 
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6 Switchboard  
The switchboard is intended to control all the accessories and feedbacks in your layout and to see 
what is happening with every car. As every layout is different in size, the switchboard has some ways 
to handle a large layout on the screen: 

1. Multiple tabs to show different parts of your layout directly; 
2. Separate zoom control per tab; 
3. An optional overview per tab; 
4. The option to use a ‘Wide’ layout view. 

 
To zoom in on the switchboard, there are several options: 

• Use the zoom box or the zoom buttons on the toolbar on the upper right corner 

 
• Use the scroll wheel of the mouse in combination with the <Ctrl>  or <Command>  key to 

zoom in or out at the location of the mouse pointer in the grid; 

• Use the popup menu via the right mouse button (or use <Ctrl> + click) and go to the ‘Zoom’ 
sub menu. 

 
The grid in the switchboard can be switched on and off via the popup menu ‘Show grid’ or 
<CTRL>+<G>. 
 
Quality 

The option ‘Anti-Alias’ should always be switched on unless your 
graphics processor is quite old and slow. It will make all drawing more 
smooth. It is checked by default. 
The option ‘Interpolated’ enhances the quality of imported images in the 
switchboard when being scaled. It will degrade the drawing performance 
and is only recommended on systems with very good graphics 
performance. It is unchecked by default. 
‘Zoom’ provides a number of standard options for zooming in / out. In 
addition, ‘Fit’ can be used to present the layout plan in maximum size in 
the switchboard. The other 2 options will present the layout as far as 
possible in width or height. 
 

6.1 Overview 
This overview option in the 
popup menu of the switchboard 
adds an extra overview pane at 
one side of the switchboard (for 
example at the bottom with 
‘Overview south’) or in a 
separate window. 

 
 

 
 
 
 
 
 
 



 

23 
©2020 MCC ModelCarParts 

In the overview the whole switchboard is shown with a rectangular box that shows which part has 
been zoomed in. This is very useful if your layout is quite big and you want to control only a part of it, 
but at the same time keep an eye on the whole and be able to switch to another part very easily. 
There are two ways to manipulate the visible part in the switchboard via the overview: 

• You can drag the box in the overview to move the zoomed in area; 

• You can select an area in the overview with the mouse (starting with a selection outside the 
current box) to show what should be shown in the switchboard. After selecting an area it 
might change to keep aspect ratio of the switchboard space. 

 
Layout view 
Next to the standard layout there is also a wide layout where the whole width of the window is used 
for the switchboard and the car controls are put below the switchboard. This makes more space for 
all the columns in the ‘Car overview’ and is also useful for layouts that are very wide but do not need 
the full height of the screen. It is available via the menu ‘View => Layout => Wide’. 
 

6.2 Controlling switchboard 
Every accessory (like a turnout or traffic light) or feedback can be (de)selected or changed by single 
clicking it. For different objects the behaviour might be slightly different: 

For turnouts it will change from straight to branch or the other way. A special case is a three 
way turnout that is actually considered as being two turnouts that cooperate. If the state of 
one of the turnouts is branch it will go to straight. If the state of both turnouts is straight the 

change depends on which side you click and it will only change this side of the turnout. In case you 
want to select a state directly, just press down the mouse button on the turnout until a popup with 
all states appears, and select one. 
 

Traffic lights will change between red and green. In case you want to select a state directly, 
just press down the mouse button on the traffic light until a popup with all the states appears, 
and select one. 
 
 
 

Feedbacks are toggled by clicking when the control system is offline, but if your control system is 
online it will set the feedback according to the state read from the interface and you cannot change 
it. 
 

Lanes cannot be switched and in this case a dialog pops up to select a 
car that is in the lane (or no car) 
You can also attach a car to a lane by drag & drop. You either select a 
car from the ‘Car control’ or ‘Car overview’,  or you select a car from the 
switchboard itself and drop it onto a feedback in the lane.  
It is also possible to select a car on the switchboard and move it to 

another lane. 
With ‘Insert’ or ‘Add’, cars can be placed in the lane. Make sure the position is not known and the 
order of cars is correct! 
Selecting a car in the list and then selecting ‘Remove’ will remove the car from the lane. Make sure 
that the car is actually off the road because it is no longer seen when driving automatically. 
The ‘Up’ and ‘Down’ options provide the option to adjust the order of cars. The advice is not to use 
this because it can completely disrupt driving behavior. 
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6.3 Create or edit the switchboard 
To create a new switchboard or to edit a current one, select from the menu ‘Edit => Switchboard’ or 
press <Ctrl> + <F4>. If you do this for the first time you will be asked to enter a name for the first tab. 
You can modify it later, so if you do not know or only need one tab, just enter ‘Main’. 

 
You will now see the above screen. The switchboard is at the centre. At the top you see a toolbar 
with some actions. On the right side is the toolbar with all the elements you can put on the 
switchboard.  
On the left side there is an optional ‘Browser’ with all objects currently defined in iTrain that may or 
have been attached to the switchboard. 
In the grid you see the cursor shown as a red rectangle that you move with the cursor keys or by 
clicking in the grid with the mouse. 
To draw elements in the switchboard the preferred way of working is to select an element on the 
right (by mouse or better with the keyboard), turn it into the right position using the <Left> tor 
<Right> arrow key and then go to the switchboard and press <Space> to add the element. You can 
continue by selecting another cell with the arrow keys and pressing <Space> again. Elements can be 
rotated in the drawing as well as on the element toolbar. 
To change the size of the grid, you have to use the <Alt> key in combination with the arrow keys: 
<Left> or <Up> to decrease the grid size in horizontal and vertical direction; <Right> and <Down> to 
increase the grid size in horizontal and vertical direction. Elements outside the grid are not removed 
but are just not visible anymore. 
It is also possible to double click the element on the element toolbar to add an element to the 
switchboard. However, this slows down the drawing process when having to add multiple elements, 
because you continuously have to change the focus between toolbar and switchboard. Try to learn 
some of the key commands and you will be able to draw your layout very quickly. In Appendix A of 
the iTrain manual all the key commands available are described. 
When using the keyboard to enter commands, the focus is important. The best practice is to keep the 
focus on the switchboard (highlighted cursor) and select elements from the toolbar via key 
combinations. When you are holding the <Ctrl> or <Command> key you are navigating through the 
toolbar: 

• Cursor Up/Down to select the items on the element toolbar; 

• Cursor <Left> or <R> key to turn the selected element on the toolbar counterclockwise in the 
preferred direction; 

• Cursor <Right> or <T> key to turn the selected element on the toolbar clockwise in the 
preferred direction. 

 
From the switchboard you can now easily edit the grid: 

• <Cursor> keys to move the cursor in the grid; 

• <Space> key to add an element from the toolbar to the switchboard; 
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• <R> or <T> key to turn an element in the switchboard counterclockwise or 
clockwise; 

• <Alt> + <cursor> keys to change the size of the grid; 

• <Shift> + <cursor> keys to select an area of the switchboard; 

• <Shift> + <Alt> + <cursor> keys to change the size of elements that can 
cover multiple cells; 

• <Shift> + <Control> or <Command> + <cursor> keys to move a selected 
element or area over the switchboard; 

• <Del> or <Backspace> key to delete an element. Only the element on top 
will be deleted if one cell is selected. If the selection contains multiple 
cells, all layers will be deleted; 

• <Shift> + <Del> or <Backspace> key to delete an element. Only the 
element below will be deleted if one cell is selected and two elements are drawn on top of 
each other. If the selection contains multiple cells all layers will be deleted; 

• <Ctrl> or <Command> + <X> to cut the current selection and copy it to the clipboard so that it 
can be pasted later; 

• <Ctrl> or <Command> + <C> to copy the current selection to the clipboard so that it can be 
pasted later; 

• <Ctrl> or <Command> + <V> to paste the elements on the clipboard at the cursor. If the 
elements do not appear where they should do, you can move them again with <Shift> + 
<Ctrl> or <Command> key + <cursor> keys or delete them with the <Del> or <Backspace> key 
to undo the paste operation; 

• <Ctrl> or <Command> + <Z> to undo a move, a cut or a delete. Once the selection changes, 
you cannot undo it anymore. 

 
Note: Once an area (more than one cell) of the switchboard has been selected, you cannot use the 
curve and turnout elements from the toolbar anymore. Select a single cell to be able to use all 
elements again. 
 
Tip: The popup menu (click right mouse button) of the switchboard in edit mode contains some of 
these commands (with their key equivalents). The same zoom functionality is available in edit mode, 
only without the overview function. 

6.3.1 Toolbar 

The toolbar on the right may contain more elements than your screen can display. The 
elements are grouped. Via the popup menu (right click) you can select which groups 
are visible. If your space is limited, it is recommended to deselect some of the 
elements. For cars are available ‘Road elements’, ‘Road connections’, ‘Others road’, 

‘Control elements’ and ‘Draw elements’. 
 
Once the focus is on an element in the toolbar, the following key commands can be used: 

• Cursor <Up/Down> to select the elements; 

• Cursor <Left> or <R> key to turn the selected element counterclockwise in the preferred 
direction; 

• Cursor <Right> or <T> key to turn the selected element clockwise in the preferred direction. 
 

The road elements are meant to draw the lanes. The first element is the straight lane and the second 
and third are both a curved lane. The fourth element is the arrow that indicates the direction the car 
is driving. Each lane should at least contain one arrow for direction. The fifth element is a closing 
element, if a lane is continued on another tab. This closing element can be used as a button to jump 
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to another tab when all the lane definitions (explained later) are set correctly. The next element can 
display a deviating maximum speed form the lane or indicate a lane being inactive. 

 
Note: If the car is allowed to drive in both directions, just select one direction or select the 
preferred direction, but do not put two arrows in the opposite direction. In the lane properties 
(explained later), you can define which directions are allowed in the lane and if necessary the 
element will change into a double arrow automatically. 
 
The turnout elements are just a preselection of some of the possible types of turnouts. You can 
change the type later on by double clicking the turnout and selecting a type. 
The ‘Others road’ are elements that are drawn into a road element. The first one represents 
the lane. It is used as the display of the lane to show the cars into the lane and it may cover 
more than one cell. In edit mode it will show the name of the lane if the zoom level is 125% or 
more. The second element is a feedback on your layout. 
Next is the traffic light and is drawn on a straight lane so that it is always clear to which lane it 
belongs. 
The last element is the intersection. This is used to define the lanes coming together into an 
intersection.  The intersection is used to control the traffic lights corresponding to the lanes. 
 

Tip: The lane element grows dynamically and may cover more than one cell when a name appears 
into it. Take this into account when drawing your layout, and do not put other non-road elements 
next to it that may be covered and will not visible anymore at that time. 
 
Note: Traffic lights belong to the lane in which the car will stop and not to the lane they are 
protecting. This is a more practical decision to make it easier to define a situation where lanes are 
connected by a turnout and the signal is placed before the turnout, but is protecting the lane after the 
turnout. 

6.3.2 Layers 

There are no specific elements for tunnels and bridges, because you can draw elements on top of 
each other. When you draw a new element over another element in the same direction, then it will 
replace the current element. If you draw it in a different direction, then it will be drawn on top of 
another element with a kind of transparent gray bridge element. 

 
If only a single cell has been selected, then actions like delete, move, copy will act on the element on 
top. If more than one cell has been selected, the actions will act on all layers. 
Tip: In case you see the gray layer drawn on some elements, but there is no purpose for two layers, 
you probably have put two elements on top of each other, but afterwards turned the element on top 
in the same direction as the one below. This is an error and may give unwanted results later on. You 
can correct it by selecting the cell and 
press <Shift> + <Del> to remove the element below. Now the gray layer should disappear. 
 
When you control the layout, it is no problem to switch an element (for example a turnout) that is 
below a normal track element. Only the top most switchable element is switched and so non-
switchable elements on top of switchable elements are not a problem, but prevent two switchable 
elements on top of each other if you want to be able to control them manually. 
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6.3.3 Browser 

The browser on the left gives on overview of all the control objects defined in iTrain that can be or 
are attached to elements in the switchboard. You can assign control objects to a switchboard 
element by drag & drop. Normally, you immediately create a control object together with the 
switchboard element. 
 
Tip: The browser can be hidden by using the ‘Browser’ button on the toolbar to get more space for the 
switchboard. Hitting the same button again will bring up the ‘Browser’ again. 

 
 
In the browser you can rearrange control objects by drag & drop within the 
browser or you sort the objects by name by double-clicking on the column 
header. You can also remove control objects that are of no use anymore, 
but be careful with this, because once deleted you cannot restore them 
anymore. Removal of an object can be done via the popup menu (right 
click) or via the <Del> or <Backspace> key. 
To select an object in the browser via the switchboard, you have to use 
<Ctrl> or <Command> + double-click on the element in the switchboard, or 
use <Ctrl> or <Command> + <Enter>. To find and select an associated 
element in the switchboard that is attached to an object in the browser, 
you can just double-click or select it and press <Enter> in the browser. 

 
Tip: The overview can be hidden by pressing the ‘Overview’ button above 
the switchboard. This means there is more room for the switchboard. By 
pressing the same button again the overview will reappear. 

 

6.3.4 Template 

You can also create new control objects based on other control objects via the ‘Template’ action in 
the popup menu of the browser (right click). This is useful if you have to create multiple objects (for 
example turnouts or feedbacks) with almost the same name and description, but only with another 
number in it. 
 

  
 

You first select a control object from the browser that is used a 
base definition. Then you select ‘Template’ or you press <T>. In the 
presented dialog, you put a <#> character where the number 
should be inserted and in the ‘Range’ section you define the 
numbers that will be generated. In the example, 3 traffic lights will 
be created with the names VKR1, VKR2 and VKR3 and with a 

description with the same number in it. Other properties of the base object will also be copied 
except for the ones that are naturally different, such as address, comment and other things that are 
unique for every object. 
If the ‘Correct existing one’ flag is checked, then also existing control objects will be changed so that 
they now have the same properties as the reference. 
 
Tip: The ‘Template’ action can be used to create many turnouts, traffic lights and feedbacks that are 
almost the same. You only have to add the address manually. Even if you have already created these 
more or less equal objects manually, you can use ‘Template’ to assure that. 



 

28 
©2020 MCC ModelCarParts 

 

6.4 Assign control objects 
In the switch board you can draw turnouts, traffic lights, feedbacks and so on, but these drawing 
elements must be attached to their underlying control objects. For every control object there is only 
one object identified by its name, but it can be drawn multiple times on the switchboards, for 
example in different tabs. 
You can create and/or attach the control object to its viewing element in the switchboard by double-
clicking the element. A dialog with two tabs will be shown: 

• The first tab shows the properties of the board element or viewing element. You can select a 
control object from a list with already defined objects that you want to attach to it, or select 
the first entry starting with ‘<No...’ if you want to define a new control object on the fly. If 
you change the selection it will automatically select the second tab to edit its properties. 

• On the second tab you can change the properties of the selected control object or add the 
data of a new control object. 

 
 
For example, when you double click a traffic light element, the ‘Signal properties’ dialog shows up. 
You have to select one from the drop down box or go to the second tab and enter a new signal. 
 
Key mappings 
To assign a key combination to an element, you can use the key mapping feature. Just select the 
‘Key’ box and use the key combination you want to use, including modifier keys like <Shift>, <Ctrl>, 
<Alt> and <Command>. The text starting with ‘Code’ should change to represent the pressed key 
combination. This key combination is only valid on the tab of the switchboard where you assigned it, 
and doesn’t belong to the control object itself. This way you can reuse key combinations on different 
tabs, for example for different stations. 
Tip: Make sure you do not override an already existing system or program key combination, as you 
might get unexpected results. The <Esc> key is to remove an existing key combination and cannot be 
used in key combinations, because it is reserved to ‘Stop’ the system. 
When you press ‘Ok’ on the dialog, the changes on the control object are stored in the object even if 
you later cancel the drawing in the switchboard editor. 
 

6.5 Feedbacks 
Feedbacks or sensors are the eyes of the system. They notify which part of the lane is occupied or 
what point on the lane was passed. In general, they can cannot see who was responsible for it, but 
only that something happened. Also see Appendix B for more background information on feedbacks. 
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Feedbacks have an address, an interface, a type and depending on the 
type a length. It is recommended to specify the type especially when it is 
of type ‘Occupancy’, because it will affect the behavior in lanes. 
 
Only for a feedback of type ‘Occupancy’ you can enter a 
length of the feedback. This length is used to calculate the 
positions of the feedbacks in the lane and will be used to 
release previous lanes earlier. 
 
The ‘Inverted’ box allows to interpret the feedback the other way so that 
‘0’ is occupied and ‘1’ is free. This is the default setting for a feedback of 

type ‘Light barrier’. When a feedback is inverted you see the inverted value in 
the switchboard. In the feedback monitor (mentioned later in this manual) you see the original input 
from the interface on the border/edge of the element and the inverted value at the inside. 
The ‘Delay’ of the feedback when switching them on or off is normally specified per interface, but 
you can override the values here for a specific feedback. When ‘Default’ is checked, you will see the 
default value in gray. 
 
Tip: If the switchboard editor is zoomed in at least 200%, the feedback elements will show their name 
inside the red box. This is useful to check all your names in a big station on consistency. 
 

6.6 Accessories 
For all accessories you normally have to fill in the address box. If the accessory, for example a traffic 
light, does not really exist in your layout, but you want to add it to the switchboard (for example for 
hidden tracks) to show the internal state of the lane, use address zero or leave it empty. 
 

A turnout is an accessory with one address and two or three 
states.  
The ‘Activation time’ box specifies the time between the 
activation of the accessory and the deactivation and must 
normally not be filled in. ‘Default’ must be selected to use 
the default of the interface as specified in the Interface 
editor. In some cases you might want to divert from the 
default settings and you can fill it in here. 
 
The state mapping tab allows you to exactly specify the 
outputs on the decoder that will be activated for every state. 
For every accessory and turnout they will have a good default 
value so that you do not have to change it in most cases, but 

you can if you want to. You can switch at most four outputs for every state change (for example, for a 
three way turnout you need two to set both sides). You can select from the addresses specified 
earlier. This way the mapping order is independent from the address and when you change the 
address the mapping will change accordingly. 
The ‘Enabled’ column makes it possible to disable a state when it is no longer possible to select that 
state due to a mechanical or electrical defect (for example the coil doesn’t work or a wire is broken) 
or when the state is not supported by your accessory. Just keep the output settings so that you can 
continue when the defect has been fixed. Disabling a state will have effect when changing the state 
in the switchboard manually, but also when 
using car routes. Cars will not consider this state an option anymore and will choose another option if 
available (in case of alternative lanes). 
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In most cases you will use the ‘State mapping’ to change the outputs of a turnout that was connected 
the other way around. You can select the two states for which the outputs need to be swapped, and 
press <S> or use the popup menu. In case you only have two states, you don’t have to select them 
first. 
 

The length of the various switch positions can be specified at 
the tab ‘Length+ speed’. These values are used in the calculation 
of the position of a car in an alternating street. The speed in this 
tab is not used yet. 
 

The ‘Options’ tab is only used for ‘Always return to initial state after release’ possibly used with cars. 
The other tabs are not used for cars. 
 

6.6.1 Output Device 

Dinamo/MCC users will see an extra ‘Output Device’ box to select if the accessory is 
controlled by an ‘OM32’ command, an ‘OM32 Pulse’ or an ‘OC32 aspect’.  

 
When selecting OM32 or OC32 only one address box will appear that refers to the first output used 
by the accessory. This address starts with value one for the first output (zero means no output used). 
So when an accessory is connected to an OC32 you can select to use either the OM32 commands 
generated by iTrain (easy, but less flexible) or the preprogrammed ‘Aspects’ in the OC32 that have 
been created with the OC32config tool. 
In case the accessory has been connected to an OM32, always select ‘OM32’ or ‘OM32 Pulse’. 
 
Tip: The ‘OM32 Pulse’ option generates only short pulses on the output like an ordinary accessory 
decoder or a PM32. You can use left over outputs on the OM32/OC32 for some accessories that need 
this, instead of buying a separate decoder. 
 
BiDiB users can control accessories via DCC (both standard and via aspects), but they can also control 
these directly via an output on a module in BiDiB. The latter is called "Accessory (Bus)". 
 

 
 
When choosing "Accessory (Bus)" you cannot specify an address, but you must choose a module and 
a port number. The module is the BiDiB component and the port is the local port on this module 
starting at number zero. The module can be chosen from a list of available modules. This list will be 
refreshed every time a connection is made to a BiDiB system. The info button that stands for 
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‘Identify’ will cause an LED to flash on the module, but can only be used if there is a connection to 
the system. 
 

6.6.2 Cross turnouts 

The cross is a special object that normally has no address 
(leave it empty or zero), but it is considered a turnout, 
because it can have two states on the screen (but only one 
on the layout). iTrain needs to know which direction is 
supposed to be used so that it can lock the direction for a 
car. The length is used to determine the position of a car in 
the alternating street. 
 
 
All other tabs (State feedback, Options and Comment) are 
not specific used for cars. 
 
 

 

6.6.3 Crossing 

The crossing is an element to indicate that the road crosses a track or waterway. Two types of 
crossings are available. The first is the railroad crossing and the second a bridge. In both cases they 
have the situation open and closed, but they differ in how they affect the car. 
A railroad crossing will ensure that it is closed to cars when a train passes by. Cars will stop when the 
railroad crossing is closed. 
In the case of a (movable) bridge, the car may not pass as long as the bridge is open. That is why the 
water shows (in blue) and a red line to indicate that this line may not be crossed. 
The crossing is a switchboard element with a street element. It is possible to draw as many parallel 
lanes as you want, but you must specify the crossing on the ‘Options’ tab of all lanes that are part of 
the crossing to ensure that the crossing is also activated. This does not happen with automatic 
completion. 

 
Tip: It is recommended to apply the crossing only in shorter blocks, so 
that it does not close too quickly or opens too late, because if one of 
the blocks is reserved or occupied, it will close or stay closed. 
 
The length indicates how long the road runs over the crossing. The 
other options are the same as with other accessories. 
On the ‘Options’ tab, you can enter the ‘State delay’ that indicates 
how long it takes you to get from one state to the other. In the case 
of a level crossing, this normally takes seconds and an intermediate 
state will be shown to indicate that the level crossing is opening or 
closing. 

 

6.7 Lanes 
Lanes are parts of the road where one or more cars can drive at the same time. iTrain will calculate 
the distances into a lane to allow more cars into a lane, depending of the length of a lane and the 
cars. The calculation of distances in combination with the length of the cars will avoid collisions.  
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Every lane is connected to other lanes directly or indirectly via turnouts, so each lane must know 
what its neighbouring lanes are on both sides. In iTrain the sides of a block are called ‘Previous’ and 
‘Next’ indicating the default direction of the lane from ‘Previous’ to ‘Next’.  
To indicate a lane in the switchboard you need to assign multiple road elements (with Traffic lights 
and feedbacks) to a lane. An element with the white rectangle (in edit mode with an arrow for the 
text direction or the lanename) represents a lane. It is used to define the lane. 
 

In edit mode you can assign other road elements to the lane by first selecting the lane 
element and pressing ‘Assign to group’ on the switchboard editor or the <G> key for grouping 
(see popup menu). Now all road elements that belong to that block got the colour orange. 
You can now assign extra road elements to the lane (not including turnouts) by selecting 
them and pressing ‘Assign to group’ on the switchboard editor or <G> again. You can also do 
it in one step by selecting all elements belonging to the lane (including the lane element) and 
pressing ‘Assign to group’ on the switchboard editor or <G>. To remove already assigned 
road elements from a lane, select them and use ‘Remove from group’ on the switchboard 
editor or <Shift> + <G>. By selecting an empty element cell and pressing ‘Assign to group’ on 
the switchboard editor or <G>, you turn off the highlighting of all elements belonging to the 

lane. 
Tip: The lane names will be displayed in the lane elements if the zoom level is 125% or more and you 
are in edit mode. 
 
In switchboard edit mode all elements assigned to a lane have a kind of brown colour (colour in 
between orange and black). In a well-defined switchboard in edit mode, only the turnouts are black 
and maybe some tracks between turnouts not belonging to a lane. The arrow element shows the 
direction of the car in the lane. In edit mode it will show the default direction of the lane itself and 
you have to make sure that it points from the ‘Previous side’ to the ‘Next side’, not only to get good 
visual feedback about the direction of a car in the switchboard when controlling, but also to able to 
automatically fill in some of the properties of the lane. In case both directions are allowed, the 
darkest of the two arrows should point in the default direction from the ‘Previous side’ to the ‘Next 
side’. 

6.7.1 Edit 

To edit the lane properties, you double click on the lane element or you select it and press the 
<Enter> key. A dialog with two main tabs will appear. In the first tab you see a simplified version of 
the switchboard with only the elements assigned to this lane. This can be used as a check to see if 
you did not forget to assign an element to the lane. It is this definition of the lane that is used later 
on to automatically fill in some of the properties of the lane, such as the feedbacks and traffic lights. 
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The text in a lane element will by default be horizontal so from left to right, but when the lane in the 
switchboard is drawn vertically you might want the text to be vertical as well. You can change the 
‘Text direction’ to be ‘Horizontal’, ‘Up’ or ‘Down’. The direction of the text will be displayed in the 
lane element with an arrow if the name of the lane is not displayed. 
You can now select an already defined lane definition from the ‘Lane’ input or select ‘<No lane>’ and 
define a new one on the second tab. 
 
 
Lane properties  

The type of the lane affects what car may drive the lane 
and what the maximum speeds are. 
Justifications per individual lane are possible via the ‘Speed’ 
tab, discussed later.  
The 'City' type is intended for urban areas with a lower 
maximum speed; 'Countryside' and 'Highway' are intended 
for outside the urban area with resp. an average and high 
maximum speed. 
The 'Emergency', 'Bus stop' and 'Trucks' types are intended 
for lanes in which resp. only emergency vehicles, buses and 
trucks may come. The 'Parking' type is specifically for 
parking spaces and 'Charge' for driving to a charging point, 
both with a low maximum speed. 
A lane of type ‘Charge’ is not used for random driving. This 
can only be achieved with a fixed route. 

 
The field ‘Length’ indicates the total length of the lane. This length is used to calculate the position of 
the cars within the lane. It is therefore important that this value is as accurately as possible. 
 
 
Options 
A number of generic lane settings can be defined in the ‘Options’ tab. 
 
The property ‘Direction’ of the lane: A lane can be allowed to be driven in both directions or in just 
one direction. Even if it is allowed to travel in both directions in some cases, in most cases it should 
be used in one direction. This is called ‘Preferred direction’. The single or preferred direction is 
always from ‘Previous side’ to ‘Next side’. This ‘Direction’ setting directly effects the way the arrow 
element in the switchboard is drawn and it is also used by routes (described later) to determine what 
the preferred direction is. 
 
With ‘Max count’ you can indicate how many cars can be in this lane at the same time. If this is 1 for 
a bus stop or parking space, only 1 vehicle is allowed and the lane is considered full. The next car 
must wait or pass by. In this way the traffic on the track can be distributed. If ‘Max count’ is switched 
off, there is no limit to the number of cars in the lane. The total length is then only taken into 
account, with cars connecting even if they are on turnouts. 
 
‘Weight’ gives the possibility to make a difference in lane preference. A higher value means that this 
lane will be chosen more often compared to a lane with a lower value. 
 
The property ‘Interface’ specifies the interface that is generating the signal for this lane. In case of 
the cars it will be UCCI (MCC), Dinamo (RMU) or BiDirectional Bus (BiDiB). 
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With ‘Dynamic’ a different maximum speed for a lane can be set. If an element for speed is included 
in the lane, the deviating setting will be shown there. In addition to manually, this option can also be 
controlled via actions. 
 
Only with the 'Bus stop' and 'Parking' types can the options for stopping and the minimum and 
maximum waiting times be entered for options. When stopping, the system itself chooses a time 
between the minimum and maximum value and departs automatically again. 
 
Feedbacks 
It is important to know where a car is to be able to guarantee that it will not crash into another car. 
Therefore, every lane contains feedbacks or sensors to observe what is happening in the lane. The 
tab ‘Feedbacks’ shows all the available feedbacks with their position in the lane. To fill the list of 
feedbacks, you will normally use the button ‘Auto fill’. 
 

By specifying the positions of feedbacks in a lane you have 
more information about where a car is in the lane. The 
positions are used to evaluate the calculated positions of 
cars in time. Therefore the positions should be defined as 
precise as possible. The first feedback is also used to release 
the previous lane. 
Per feedback, some extra columns are shown. At first the 
length of the feedback in case of a reed contact this is empty 
(zero). The next two columns show ‘Start’ and ‘End’ position 
of the feedback in the lane. While the length of the feedback 
is zero, the values in ‘Start’ and ‘End’ are the same. You only 
have to enter the value for start and then use the button 
‘Fill’. 
 

 
 
Note: To fill in the position of the feedbacks in the lane it is necessary that the length of the lane has 
been specified first. 
 
Entering the positions can be tedious. If the lengths of the feedbacks are filled in and you either have 
only one or two feedbacks, or the length of all the feedbacks together is equal to the lane length, you 
can use the ‘Fill’ button to fill them in automatically. Before you do that it is important that the order 
of feedbacks is correct (from ‘Previous’ to ‘Next’), and if necessary, you can adjust the order by using 
the buttons ‘Move up’ and ‘Move down’. 
 
Direction tabs 
A lane has two sides so in theory it can be driven in two directions. To distinguish these two 
directions both driving directions need to have a name. They are called ‘Direction: Previous’ and 
‘Direction: Next’. 

• Direction: Previous - is the direction from side ‘Next’ to side ‘Previous’ and in case the block 
has a preferred direction this is the non-preferred direction. 

• Direction: Next - is the direction from side ‘Previous’ to side ‘Next’ and the preferred 
direction in case of a preferred direction and the only allowed direction in case of a single 
direction lane. 

Some important properties are specified per driving direction so there are two tabs with the same 
properties. It is necessary to specify them for both directions to correctly follow the car even when 
the lane is only used in one direction. 
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Tip:The ‘Auto fill’ button can fill in most of these properties automatically. It is however required that 
all the feedbacks, traffic lights, turnouts and neighboring lanes that will be chosen already have a 
name for correct results. So it is recommended to first assign names to all these control objects and 
then use the ‘Auto fill’ button to attach them to the lane. 
   
 

The following fields can be filled in: 

• ‘Blink position’: The position in the lane where the 
blinking light might be activated. You can enter the 
direct position (e.g. 29,5cm) or define a distance before 
the end of the lane (e.g. -30cm). 

• ‘Stop position’: The last position in the lane where a car 
should or might stop. You can enter the direct position 
(e.g. 50,5cm) or define a distance before the end of the 
lane (e.g. -9cm). This position should always be behind 
the ‘Blink position’. 

• ‘Switch position’: The position in the lane where a 
turnout should be switched. Default this value can be 
zero. 

• ‘Traffic light’: assigning the traffic light that might be at 
the end of the lane controlling the traffic. 

• ‘First branch on sight’: when this box is checked a car 
can ignore redlight when turning right. 

 
Speed 
The default speeds in the lanes are specified in the general ‘Settings’, but these can be 
overridden in the box ‘Speed’ for every position in the lane. Using the buttons ‘Insert’ or ‘Append’ a 
new line while be attached before or after the selected line in the box ‘Speed’. Using the button 
‘Remove’ a selected line will be deleted. 
Every line in this box contains a value ‘position’ and ‘maximum’. These lines define the exact place in 
the lane (‘position’) where the corresponding speed (‘maximum’) should be driven. 
In this way dynamic speed can be defined within a lane (e.g. reducing speed for a curve). 
 
The last box in this tab will show the directions / next lanes 
which can be selected. If all control elements and lanes have 
been defined in the switch board, this box will automatically 
filled using the button ‘Auto fill’.  
 
‘Turn direction’: this will affect the blinking lights of the car. 

o ‘Dependent’: blinking light will be activated when car turns left or right 
o ‘None’: blinking light will not be used 
o ‘Left’: blinking light left will always be used 
o ‘Right’: blinking light right will always be used 

 
The "Side" and "Choice" columns are not used for cars yet. 
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6.8 Deleting switchboard elements 
When deleting an element from the switchboard that refers to a control object (for example a 
turnout, feedback, etc.) only the visual element is deleted and not the control object details. So if you 
accidentally delete a turnout element and then add a turnout element to the switchboard to replace 
it, you can still select the turnout object from the drop-down box. You should not define it again. 
To completely delete the control object, you have to remove it from the ‘Browser’, because then all 
references to this control object (for example in lanes) will be removed. However it is always 
preferable to edit and reuse a control object when something needs to be changed rather than to 
delete it and create a new one. 
 

6.9 Adding/Modifying switchboard tabs 
It is possible to add extra tabs or rename existing tabs by using the popup menu on the switchboard 
tab (right mouse click) in edit mode. The function always works on the active tab. The ‘Insert’ inserts 
at the selected tab, so before the current switchboard, and ‘Add’ appends a new tab at the end. If 
you want to change the order of the tabs later on, you can use ‘Move left’ or ‘Move right’ to move 
the current tab. 
When using multiple tabs, the same accessory, feedback, track route and block elements might 
appear on different tabs. In that case it is necessary to define the objects only once and to attach 
them to the 
switchboard elements on different tabs. 
Tip: Often parts of the layout of two tabs have some overlap. It is possible to select an area and use 
‘copy’ on one tab and ‘paste’ on another tab to copy parts to another tab. In that case the visual 
elements are copied, but references to the same accessory and feedback objects are used. 
 

6.10 Car routes 
Routes make it possible to automatically follow a path across the layout, using the lanes. Routes can 
exist on their own and can be assigned to one or more cars. To create or edit a route, go to the ‘Edit’ 
menu -> ‘Car routes’. 
 

 
 
Routes are a list of lanes to follow. For cars, it is important to specify all lanes where the car passes. 
All stops must be indicated in a route, even if a lane normally already has a stop. In most cases, a 
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route is made to be repeatable. In that case you have to ensure that the last lane connects to a lane 
that appears earlier in the list (preferably at the start) so that the route can be picked up again from 
an earlier point. So if a route goes from lane A to B to C and beyond, the order of lanes in route A, B, 
C. 
In the ‘Items’ tab you can press the ‘Append’ button (add at the end) or ‘Insert’ (for the selected 
element) to add an item to the list. Everything below this table applies to the selected item in this 
table. Each line in the top table shows the name and description of the lane of the item in the list. 
The symbols to the left of the name indicate that special things are happening in this lane as 
described below. 
 
Wait 
It is possible to wait in every lane along the route. A waiting time for a lane prevents reservations 
beyond this lane until the waiting time is over. A waiting time of zero means no waiting time. If a 
waiting time is specified, a clock symbol will appear in the second column of the table. 
Note: There is no sense in assigning a waiting time to the first part of the route, because it only 
contains lanes from which you can start. It is useful to assign a waiting time to the last part of the 
route, because it indicates the time that is waited until a route is repeated or terminated. 
 
Markers 
Markers are intended to indicate which parts of a route should be repeated if a repeat is specified. 
With no markers, just everything is repeated, so with simple routes they are not necessary. To add 
‘Start’ and ‘End’ markers to the route, select a lane in the table and then choose the desired marker. 
The symbols will appear in the first column of the table. The number of repetitions can be put on the 
'Options' tab and is described below. 
  
With ‘Selection’ the route can be made more dynamic, because a lane is chosen from a list. This is 
indicated by an ʻ + ʼ in the third column of the table. A lane is selected based on the value of the 
ʻSelectionʼ field. 
The options are: 
• ‘In order’ means that the first or next lane from the list of lanes is selected, unless it is already 
occupied or reserved. 
• ‘Random selection’ means that the list of lanes is first placed in random order. Then the first or 
next lane is chosen, unless it is already occupied or reserved. 
• ‘Optimal length’ means that all lanes in the list are sorted by length from short to long and that 
lanes that are too short for this car are removed. Now the first or next lane is chosen again, unless it 
is already occupied or reserved. This is to prevent small cars from occupying a long lane. It is useful 
for shadow parking places. 

6.11 Actions 
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Actions can be started automatically from iTrain if predefined conditions are met. There are two tabs 
in which the action can be defined: ‘Condition’ and ‘Execution’. 
In this manual a brief description is written for iCar. For a more detailed description, reference is 
made to the iTrain5 manual. 
 

6.11.1 Condition 

Under the ‘Condition’ tab, several conditions are possible for cars to start an action: 
• Time: on a predefined day and time; 
• Feedback: one or more feedbacks are actived; 
• Aspect 
• Relay 
• Transition 
• Booster 
• Battery: residual capacity of a battery for a certain car or all cars; 
• Lane: when a car reserves, enters, releases, waits in or leaves a lane. 
 
It is also possible to start an action independently of a condition with a button on the switchboard. 
The field ‘Auto’ can indicate whether the action is intended for a specific car or general. In the latter 
case it says ‘<all cars>’. With ‘Type’ you can indicate whether an action is for a specific type of car (eg 
Bus). 
 

6.11.2 Execution 

Under the ‘Execution’ tab, the steps associated with the action can be defined. Clicking on the field 
'Type' with the right mouse button brings up a list of several types of steps that can be included in 
the action: 
• Accessory: switching an accessory (eg turnout) 
• Aspect: the direct switching of an aspect (only for OC32) 
• Switch: switching a switch 
• Signal: switching traffic lights 
• Light: switching light (eg street lights) 
• Sound: switching sound on / off 
• Transition: operating a railway crossing or bridge 
• Autoroute: starting or stopping a route 
• Car function: operating a car function (eg flashing lights on) 
• Auto shunt: direct control of the car 
• Auto Permission: changing permissions for lanes 
• Current car: assigning a current car to a lane 
• Lane active: making a lane active or inactive 
• Lane speed: adjusting or resetting the maximum speed 
• Intersection: activating an intersection 
• Time: the immediate setting of a time 
• System: giving commands to the system (eg emergency stop) 
• Command line: execution of a directly specified command 
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There are 4 columns in the list of actions. With ‘Delay’ you can indicate after how many seconds the 
next operation must start. With ‘Type’ the type of operation is displayed. ‘Item’ indicates which 
action is performed and with ‘Change’ what needs to be done. In the example above, the route is 
stopped 11 seconds after the ‘FTP STOP’ action is started. After 6 seconds the flashing lights are 
switched off and 2 seconds later a new route is started. 
 
Switchboard 

An action can be placed on the switchboard. Then you can start an action by clicking on it. 
If the action is running, the color will change and a number will be displayed with the 

number of active versions at that time. To interrupt and stop the started action, use ‘Shift’ + click. 
Now the action will not continue, but nothing will be reset to the original value, so be cautious about 
stopping current actions 

6.12 Reservations 
On a digital layout,  you can run your cars anywhere via manual control. The computer adds lane 
control and makes sure that when you enter a lane, the cars in a lane will be protected for collisions. 
Here is where the reservations come in. A reservation reserves a positions in a lane for a car, and for 
other cars this position cannot be claimed. In the switchboard a reservation is indicated by a the 
name of the car in the ‘lane element’ and also in the ‘feedback element’ where the car is supposed to 
be or was last. 
The same principle holds for reservations of turnouts that connect the lanes. When a car is in one 
lane and reserves the next lane, then it is also necessary to reserve the turnouts that connect those 
two lanes (if there are any). You can see that a turnout is reserved by a ‘lock’ symbol and the 
reserved colour (kind of yellow/orange). This prevents others from changing the turnout state until 
the turnout is released.  
 
Reservations for lanes and the necessary turnouts will be done automatically.  
Reservations can be undone by holding the <Shift> key and clicking on a car in a lane element. This 
will remove the reservation in the actual lane. 

6.12.1 Release lane 

A car is normally in one lane and we call this the ‘Control’ lane. The feedback  (position) in the lane is 
coloured red 
and the name of the car is displayed in black letter in the lane and feedback element. Sometimes the 
tail of the car is still in another lane. This is called the ‘Release’ lane, as it will soon be released when 
the car has moved to the control lane.  
Note: If a switch or crossing stays at the reserved state, it can be released manually by holding the 
<Shift> + <Alt> key and clicking at the switch or crossing. 
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6.12.2 Removing cars from lanes 

We have seen a way lanes will be released automatically. There is another method to remove a car 
from a lane, by holding the <Shift> key and clicking on a lane or feedback element. This will remove 
the car from the lane. When there are more cars in a lane you can release all cars form the lane by 
holding the <Shift> key and clicking on the lane element. If you just want to release one car from the 
lane then hold the <Shift>  key and click on the feedback element the car is at that moment. 

6.12.3 Moving cars over or into the switchboard 

When putting cars onto the layout or manually moving a car from one position on the layout to 
another position on the layout, you also have to change their position on the switchboard. To put a 
car from somewhere into a lane, you can drag a car from the ‘Car control’ or ‘Car overview’ or a block 
element in the Switchboard  and drop it unto a feedback element.  

6.12.4 Deactivating lane 

A lane can be deactivated by holding <Ctrl> + <Alt> key and click on the lane element. The lane will 
colour light grey indicating it is inactive. If a speed element is included in the lane, it will show a red 
cross. No cars will enter this lane anymore. 
To activate a lane the same key combination is used. The lane will colour dark grey indicating it is 
active. 
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7 Feedbacks, accessories and intersections 
Next to the cars, car routes (not used yet), lanes and intersections you can also edit the ‘Feedbacks’, 
‘Accessories’ and ‘Intersections’ via the ‘Edit’ menu without going to the switchboard first. This is 
useful to quickly change a definition or to manage the list of objects. 

 
 
 
 
 
 
 
 

A dialog will appear with at the left side a list with the objects of a type (feedbacks or accessories) 
known by iTrain. To manage the list of objects you use the buttons below the list. You can add a new 
object by using the ‘New’ or ‘Copy’ button. In case of ‘Copy’ the currently selected object is used as a 
template and its definitions are 
copied to the new one. Only the name is adapted to create a unique name. The ‘Delete’ button 
removes the currently selected object from the list. 
 
Note: The ‘Delete’ button really deletes the control object and it will remove all references to this 
object from other control objects. Only delete an object if you are sure it is not used or referenced 
elsewhere or it could give unexpected results. Never delete a control object and create a new one, 
because you want to change the name or address. 
 
On the right side you find the specific object editor to change all object definitions. Youhave to fill in 
at least a name and in many cases an address. 
The buttons below the editor give some extra control over the editor: 
The ‘Apply’ button applies changes you have made in the input fields. This will immediately be 
reflected in all windows. If you select another object, the previously selected object will 
automatically be applied; 
The ‘Reset’ button discards the changes you made in the editor and reloads the fields with the 
current value. After an ‘Apply’ a reset will only discard changes made after the ‘Apply’; 
The ‘Clear’ button clears all the fields. 
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7.1 Accessories 
If you want to add a new accessory, there are two options: 

• Use the ‘New’ button. There will be an entry field with 7 options. For cars, in 
particular 'Turnout', 'Signal' and 'Crossing' will be used; 

• Use the ‘Copy’ button to create a new accessory based on an existing one. In that 
case, the type can no longer be changed, except for other types within the same type 
(for example, turnout type). 

 
Properties 

The editor allows you to edit properties of an object via 
the list of objects, but you need to look up the element 
again. It is also possible to edit an object directly by 
clicking the right mouse button while the mouse is above a 
specific object at the switchboard and selecting 
‘Properties’ in the popup menus or context sensitive 
menu. You will get a dialog with only the specific object 
editor and you can change properties instantly. 
In the switchboard you can right click on the lane element 
and edit the lane (first option) directly. 

In the ‘Car overview’ you can right click on a row and choose ‘Properties’ from the popup menu to 
edit the car directly. 
 

7.2 Intersections 
The editor allows to define the 
intersections. At the right side a name and 
description can be entered.  
At the tab ‘Lanes’ only the lanes ending 
into an intersections are defined. Most of 
the times these are the lanes containing 
traffic lights. The setting in the ‘Nr’ column 
can be used to determine how many lanes 
are released simultaneously. All lanes with 
the same number get green 
simultaneously. This can be used, for 
example, with opposite lanes at an 
intersection. 
 

With ‘Duration’ the time can be set for the lane to turn green. 
 
On the ‘Options’ tab you can set the time that is waited after the previous traffic light turns red and 
the next turns green. With the choice of ‘Smart’, only lanes with cars are considered, so that 
unnecessary waiting times are not created. 
 
Intersections will be activated by an action or double click in the switchboard. Traffic lights on the 
intersection will be switched automatically.  
Pressing the <Shift> key and click on the intersections will switch all the traffic lights in blinking 
position. The first car arriving at the intersections will pass through. 
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8 Extra tools 
The extra tools are available via the ‘View’ menu. 

8.1 Diagnosis 
Diagnosis is a tool to find problems or inconsistencies in the object definitions of your job. After the 
tool is started up, the layout will be searched immediately and the results will be shown in a table. 
 

 
 
The list is first sorted by the severity and then by the type of problem. There are three main groups: 

 Error - This is wrong and must be resolved as quickly as possible. 
Warning - This is probably not entirely good or incomplete. iTrain will work better if this is 

solved. 
Information - This is not a problem at the moment, but can become a problem in the future. 
 

Ideally, the list is empty, but it is no problem to keep some information messages in it as a reminder, 
for example to take speed measurements for inactive cars later. 
You can click on a line to edit the underlying object or source. Use the ‘Start’ button to search again 
and the ‘Stop’ button to interrupt this. The ‘Copy’ button will put the selected rows on the clipboard 
so that they can be sent to the forum or in an email. 
 
Tip: In the event of unexpected problems, it is recommended to first run the ‘Diagnosis’ 
to see if there is a problem before you ask for help. This saves yourself and us time. 
 
In some cases you will not understand the problem directly from the description, because it must be 
kept short. It is then possible to search on the forum and if it is not found, ask for it on the forum. 
The number of checks during diagnosis will increase over time and it is therefore not possible to keep 
this up to date in the manual. 

8.2 Feedback Monitor 
The feedback monitor is an address based monitor tool for showing feedback states. A feedback 
monitor is available for every interface in the project that supports feedbacks. 

 
Every button represents one feedback contact. If the 
button is filled it is connected with a feedback object in 
the program. A blue button means the feedback is 
activated. Open buttons are not related to feedback 
objects in the program, but still show the state they 
have received from the interface. 
A popup menu (right mouse click or <Ctrl> key + click) 
allows you to increase/decrease the number of modules 
(also with < = > and < - > keys) or to toggle between 
‘Grouping’ and absolute address mode (also the <A> 
key). 
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The feedback monitor automatically scales to fit the width of the window. By using the <F> key you 
fit the dialog window height to the current size of the feedback monitor. 
Note: Using the same address for two or more feedbacks normally indicates an error situation, and 
the button will have a red border/edge. In case feedbacks share an address because they have been 
connected via a 
relay (so that only one is actually wired at the same time), the button will have a yellow border/edge. 
 

8.3 Layout 
With Layout you can set the display to ‘Standard’ or ‘Wide’. With ‘Standard’ the switchboard is 
shown on the right and the ‘Car overview’ and ‘Control window’ on the left. With the setting "Wide" 
the switchboard is presented over the entire width of the screen and the ‘Car overview’ and ‘Control 
window’ below it. 
 

8.4 Additional views 
This option is not available for the standard license. 
The menu ‘View => Extra’ allows you to add a copy of a car overview, car grid or the switchboard in a 
separate window. You can put the extra views on a second monitor. 
In case of the switchboard it shows the same layout and object states, but it allows you to view 
another tab at the same time or the same tab with another zoom level. This will be useful if you are 
controlling a large layout that does not fit on one screen. 
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Appendix A: Defined keys 
 
For the defined keys we refer to the iTrain manual. 
 
The following key combinations are the most used for controlling cars: 

• Shift + Click on feedback => remove car from feedback; remains in lane 

• Shift + Click on lane symbol => remove all (!) Cars from lane 

• Shift + Click on turnout => cancel reservation of turnout 

• Shift + Double click on battery symbol => reset battery to 100% 
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Appendix B: iTrain user forum 
The iTrain user forum is there to inform you about and give you support on iTrain. It is available at 
http://berros.eu/itrain/forum/ via a web browser. It is not an open forum and only registered users 
can read it. You have to register with a self chosen username and password. Your registration will be 
verified by the webmaster so you have to choose a decent username or it might be refused. 
Initially it will start in English, but you can set the language and timezone you prefer.  
The iTrain forum has been divided into different sections each containing a sub-forum for a specific 
language. Each sub-forum contains the same division so you can read and ask questions in your 
preferred language by choosing the right sub forum. 
The first section ‘Announcements’ is a section to keep you up to date with the latest information 
about iTrain, such as releases and trade fairs. You cannot start an announcement, but only react on 
it. The same holds for the second section ‘Frequently Asked Questions’. 
The third section ‘Support’ is really for support questions. Here you can ask your own questions or 
respond to others. First choose the right category. Then use ‘NewTopic’ to add a new topic. 
Always choose a good subject so your question can be found easily by other users. Also provide the 
information that is necessary for someone else to help you. In many cases this involves adding your 
own layout so people can see what you have been doing. The layout must first be saved within iTrain 
as a zip-file by ending the filename with .tcd.zip and then you can add it to the forum via the second 
tab ‘Upload attachment’. 
Try to formulate your question well and read it again before you submit it. Well formulated questions 
are answered more quickly, because there is less need for additional questions that will take more 
time. For additional questions not related to the current subject you should create a new topic and 
not continue the current thread. The questions also function as a database for new users in which 
they can find answers and the better the subject names are and the shorter and more to the point 
the topic is, the easier it is to find. 
The last section ‘Enhancement request’ is for more experienced users who know what is possible in 
iTrain, but still lack some functionality or have some suggestions how to improve it. There is no 
guarantee that your suggestion will be included in iTrain within a certain time-frame, but all will be 
read and if possible discussed to get clear how it should be changed. The best ones will be 
considered to be implemented in the next or a later 
release. 
In some cases you would like to exchange some details with another user that should not be visible 
to others. In that case send a PM (=Private message) to another user. Never put your address, phone 
or e-mail address in a topic if you want contact with other users. Just ask for contact and interested 
people can respond with a PM to exchange contact details. 
Please be polite, patient and forgiving to other members both in asking and answering. We want to 
welcome new members, but also appreciate members who are spending a lot of time answering your 
questions and building this iTrain community. In case something happens that is not correct or really 
annoys you, please send an e-mail to 
forum@berros.eu so we can intervene or solve it. 


